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Chapter 3

Advanced Operation

3.1.

3.2

Having now become familiar with the Stereoscan 430 controls, sample insertion and
basic micrography the operator may find that there are still a number of effects
limiting image quality. This section describes some of these effects and ways to
reduce them. Complete elimination of all problems is often impossible, and a
compromise is usually reached. In order to get the best results from the Stereoscan
430 it is important to consider the following:-

e  Instrument familiarity

e Photographic considerations

e Choice of instrument parameters
e  Specimen charging

e  Specimen preparation

e  Using the digital store

These factors are treated separately below. In addition the ways in which the user
interface can be customised to meet the individual user's needs are described and
finally a section on troubleshooting is included.

Instrument Familiarity

To get the best results from the Stereoscan 430 it is important to be familiar with the
operations described in this document. If possible attend a Leica Cambridge
operators course which can be arranged by your local Leica representative listed in
Appendix D of this Manual.

Photographic Considerations

A good micrograph is sharply focused, free of astigmatism, noiseless, with optimum
contrast and brightness. These factors are very user dependent but are easily
achieved with a little practice. Setting image levels correctly results in an image
which is better looking and more readily interpreted. Understanding how to
manipulate grey levels allows tailoring of images for specific purposes.

The camera and record CRT or video copier/printer should be correctly calibrated
and the signal waveform should be evenly distributed between the upper and lower
video level markers, nearly spanning the range but never going outside the limits set
by them. Try to select the profile scan position on the image to span the brightest
and darkest areas to give a representative sample of grey or video levels. The
display look-up table editing facility can be used to create a 'visual' exposure meter
that clearly indicates lower and upper levels in the grey scale. This is a
modification of the display look-up table, where the black level is changed to blue
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and the white level changed to red. Hence, an image containing a good grey scale
range will just begin to show areas shaded blue and red. With this look-up table
active, areas of too low a signal show blue whereas areas of too high a signal show
red. See Section 3.7.1 The Display LUT Editor.

Other forms of display LUT can be used to enhance the contrast or adjust the
brightness of the frozen image.

Many samples exhibit a small amount of charging due to oxide layers or other
surface coatings. These samples show changes in signal level and contrast with
scan speed. For live micrographs of these samples, the signal should be set up using
a scan speed similar to that to be used for the photograph. The image store is
particularly useful, as it can be used to save film by allowing the image to be
acquired and checked before photographing it. Also, many identical prints may be
taken without the need to scan the sample again.

Choice of Instrument Parameters

Instrument parameters have a large effect upon the final image quality. To some
extent the parameters chosen are dedicated by the sample and its interaction with
the beam. For each different specimen, some experimentation will usually be
required before arriving at the optimum conditions. Having achieved these
conditions, they may be saved on disk (as a Macro file) for future reference, see
Section 3.7.2 The Macro Editor.

Accelerating Voltage (EHT)

The accelerating voltage, or beam energy, is one of the most important factors in
achieving a satisfactory sample examination. It will affect:-

. Damage to the specimen by the beam
. Visible surface detail

& The production of X-rays for analysis
® Image resolution

In determining the accelerating voltage, the following factors must be considered:-

Beam Damage

If the specimen is beam sensitive, a higher accelerating voltage will result in a
greater risk of the sample being damaged by the beam. This can introduce artefacts
into the image which may appear as cracking or darkened areas in the image. The
cause of this phenomenon is a localised heating or ionisation of the specimen in the
area of examination, hence the problem worsens as the magnification is increased.
Beam damage can also be the result of using too high a probe current, thus the
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accelerating voltage and probe current should both be adjusted together to
determine the optimum settings. This problem is usually exhibited by low atomic
weight specimens such as plastics or biological samples. Coating the specimen with
conducting film such as gold often helps to dissipate the heat generated by the
beam. However, better results are usually obtained by operating at lower voltages.

Surface Detail

The accelerating voltage of the electron beam directly affects the amount of surface
detail seen in the image. This is most easily understood by considering the
simplified beam-specimen interaction volume shown in Figure 3.1.

Accelerating Voltage — 25kV
Sample — Aluminium

Charactenistic
X-fays

X-Ray Continuum

Figure 3.1
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The zone of primary excitation increases in depth and diameter with a high
accelerating voltage. Backscattered electrons which are generated mainly beneath
the specimen surface possess enough energy to ionise one or more specimen atoms
before escaping from the specimen surface. Each of these ionisations produces
more secondary electrons which are added to the true secondary electron signal and
result in a loss of surface detail. The use of too high a voltage also results in parts
of the sample exhibiting very bright edges. The 'edge effect' is caused by the
electron beam completely penetrating the edge of the feature, so that secondary
electrons are produced from a larger effective surface area, see Figures 3.2(a) and

3.2(b).

Figure 3.2(a) Sample of fractured aluminium at
high voltage showing edge effect
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Figure 3.2(b) Sample of fractured aluminium at
low voltage without edge effect

X-Ray Analysis

The production of X-rays from the specimen is caused by the removal of an electron
from one of the atom's shells and the subsequent re-arrangement of the remaining
electrons. The initial removal of an electron is caused by the primary electron
beam, therefore the beam energy must be sufficient to overcome the binding energy
of the electron to be removed. X-rays may be emitted as a result of ionisations
within any of the electron shells - K, L or M and are then termed, K, L or M X-rays.
The energy required to stimulate a particular X-ray is known as the critical energy,
therefore if the energy of the primary beam is less than the critical energy, no X-ray
is produced. Thus, for example if analysis for iron is required, then the beam
energy must be at least 6.4KeV (to produce an iron K peak). In fact, for ideal
analysis (especially quantitative) the accelerating voltage should be 1.5 to 2 times
the critical energy of the highest energy peak to be analysed; this is known as the
“overvoltage'. Samples that charge, or are non-conducting should be coated with a
suitable material chosen to give electrical and thermal conductivity, but not to
interfere with the elements specifically being analysed. For example, if carbon is
the element of interest in the spectrum then it would not be a good idea to coat the
sample with carbon. In this case, aluminium would be better because it has a
sufficiently low atomic number not to attenuate too much of the carbon signal
(whereas coating with gold probably would).
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Resolution

Resolution can be defined as the minimum distance by which two adjacent features
can be seen to be separated, as two discrete points. The best resolution is usually
obtained at high accelerating voltages since the shorter wavelength of electrons at
high voltages minimises any diffraction.

Other instrument parameters also significantly affect the resolution achievable
including Probe Current, Working Distance and Aperture Size.

Probe Current

The probe current is defined as the total electron current reaching the specimen
surface. The value can be adjusted from the user interface in the range 1pA to 1pA.
In most cases, a value of 100pA gives a good video signal without over exposing
the sample to electron bombardment. Other settings would be as follows:-

High Resolution: 5pA to 25pA
Backscattered electron imaging: 200pA to 500pA
X-Ray analysis: 600pA to InA
Charge or beam sensitive samples: 10pA to 20pA

The improved resolution performance at low probe currents is achieved because the
diameter of the beam on the specimen is reduced. A larger beam diameter is
acceptable for X-ray analysis because of the larger volume of interaction (see Figure
3:1).

Working Distance

Working distance is defined as the distance in millimetres between the bottom of the
lens and the sample surface. In common with many of the other SEM parameters,
choice of working distance for the specimen may have to be a compromise. The
factors to be considered are:-

1. As the working distance is decreased the available resolution increases.
The optimum position is in the range 3 to 10mm.

2 If the sample is large, such that areas other than that being imaged come
into contact with the lens or backscattered electron detector, it is wise to
use a longer working distance.
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3. The retractable backscattered electron detector occupies a finite space
beneath the final lens. All parts of the sample should therefore be just
clear, particularly when the detector is to be moved in or out of position. A
safe working distance is 12mm.

4. The geometry used for X-ray analysis, at a 35° take-off angle, dictates that
the surface to be analysed should be at a working distance of 25mm.

S, An improvement in depth of focus, the vertical distance over which the
sample appears to be in focus, can usually be made by increasing the
working distance. An increased working distance has the effect of
decreasing the angular aperture of the electron beam. (See Figure 3.3)

Figure 3.3 Enhancement of Depth of Focus

Item 5 above directly conflicts with item 1. However, improvements in depth of
focus are usually required at relatively low magnifications where the minimal loss of
resolution caused by using a longer working distance would not be noticed. Depth
of focus can also be improved by using a smaller aperture, say 30ptm or 20um, or by
selecting Optibeam depth of focus mode. This selects the lens settings which give
the greatest depth of focus while maintaining the selected probe current.
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3.35.

Specimen Tilt

Tilting the specimen can greatly affect the SEM image, not only by changing the
area excited but also by altering the zone of secondary electron emission. The size
of this zone varies with the angle at which the primary beam strikes the specimen.
When the specimen surface is perpendicular to the beam, the zone from which
secondary electrons are emitted is smaller than when the specimen surface is tilted.
Since more secondary electrons are emitted, the tilted surface gives a brighter
signal. Tilting in the range 20 to 40° gives the best result. Very often, a small
amount of tilt adds some depth to the final image which gives more visual appeal
than a flat image.

Other Parameters

In addition to the parameters mentioned previously, the following should all be
checked:-

Electron gun correctly aligned
Stigmators correctly adjusted
Aperture centred

Correct film speed selected
Gamma and derivative as required
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Specimen Charging

Electrons incident upon the sample which do not escape as backscattered or
secondary electrons are absorbed by the sample. Unless these absorbed electrons
can find their way to ground (as in a conductive sample) they will remain in the
sample resulting in a negative charge build up exhibited as one of the following
image defects:-

e Loss of image contrast (see Figure 3.4)

e Very bright or dark areas (see Figure 3.5)

o Image or beam shift (shearing) (see Figure 3.6)

Dust and other debris on the sample surface can also charge up, and appear as a
bright area on the image surrounded by a dark region. The charged debris may
deflect secondary electron emission and sometimes the incident beam, causing dark
region and possibly image 'shearing' (see Figure 3.6). If the sample itself is
charging, bearn deflection will occur during scanning, the effect being seen as a
slow image drift followed by a jump back to its original position.

Figure 3.4 Loss of Contrast Due to Charging

Stereoscan 430 Operator Manual



68

Chapter 3 Advanced Operation

Figure 3.5 Bright/Dark Areas Due to Charging

Specimen charging of non or badly conducting specimens is dependent on the
charge equilibrium inside the sample. The secondary electron yield (S) is defined as
the number of secondary electrons which leave the sample for one incoming primary
electron. The corresponding number for backscattered electrons is the backscatter
coefficient (B). If the total electron yield T=B+S equals 1, the charge balance is
zero and therefore no charging occurs. If T increases above 1, the sample should
charge up positively because more electrons leave the sample than primary electrons
enter it. If T falls below 1, the sample will charge up negatively. One of the most
important parameters for changing the total electron yield T is the primary beam
energy. This is shown in Figure 3.7 which shows the typical dependence of T on
the primary beam energy Eo. If the primary = Ec,, then no specimen charging
occurs. Typically, Ec, lies between 500eV and 2KeV.
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Figure 3.6 Image Shearing Due to Charging

TA

Y

Ecy Ec2 Eo

Figure 3.7 Relationship Between Primary Energy Eo
and Total Electron Yield T
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The total electron yield can also be increased by tilting the specimen. A tilt in the
region of 20 to 40 will greatly reduce charging.

The other most important factor affecting charging is electron "dose rate”. This can
be defined as the total number of primary electrons per unit area of the specimen as
a function of time. In other words, the scan speed of the beam is critically
important. It can be seen that on some beam sensitive materials a fast scan speed
gives a good screen image with good contrast and topography (see Figure 3.8(a))
whilst a slow scan speed, ie for live photography, (see Figure 3.8(b)) causes the
image to display the defects mentioned previously. The following diagrams
illustrate this effect.

Figure 3.8(a) Taken at a fast scan speed
The above shows a sample of Ceramic

In this case, the image store can be used to acquire the image, with noise reduction
if necessary, at a fast scan speed. The stored image can then be photographed or
stored to disk.
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3.5

Figure 3.8(b) Taken at a slow scan speed
The above shows a sample of Ceramic

Specimen Preparation

Specimens which are studied in the SEM can be divided into two main categories,
namely conductors and non-conductors. Factors to consider during specimen
preparation are given below:-

!«J

The size of the specimen must be reduced (if necessary) to fit the available
specimen holders and specimen stages, but there is often an advantage in
selecting an even smaller sample size for ease of observation.

The object must be able to withstand being in the high vacuum of the
SEM; it must not change its shape, and it must not outgas. A cold stage
may help here.

It should be clean, ie free of dust, oils and greases. (Their presence can
lead to charging and contamination effects.)

It may be treated to improve the secondary yield if this is low, eg coating
of the sample with gold.

Any disturbance in the surface structure caused by preparation procedures

should give rise to surface details which are too fine to be resolved at the
magnification used to record the images.
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6. If an artefact is suspected as a result of a preparative procedure, a control
specimen should be utilised.

7 The specimen stub should be in good electrical contact with ground
potential.

8. There should be good electrical contact between the surface of the

specimen and the specimen stub, ie attach sample to stub with conducting
paint such as Silver-Dag and coat the specimen adequately if necessary.

9. The specimen stub should give rise to as few backscattered and secondary
electrons as possible. Aluminium stubs are normally used, although carbon
stubs are used for some X-ray microanalysis applications.

10. Very small particles are best mounted on a low mass foil to give rise to
minimal background signals, eg nylon film stretched over an aluminium
ring.

L. The sample must be attached to the specimen holder (stub) so that it does
not move whilst being irradiated by the electron beam.

12. The sample should be attached to the specimen holder (stub) so that all the
surface can be studied using the existing stage movements (eg tilt, rotate,
X. Y., 2).

Conductors

These fall into two groups:-

° Metallic: these are generally excellent conductors and need no
preparation
* Semi-conducting samples with a resistance of less than 10-10

ohms can be examined without special preparation
Non-Conductors
This group includes all samples which are not electrically conducting, eg those
generally not containing volatiles, eg fibres, plastics, polymers, semi-conductors
with a resistance greater than about 10 ohms.
Those generally containing volatiles, eg biological and botanical material.

Non-Volatile, Non-Conductors

If it is not possible to obtain suitable resolution by using a low accelerating voltage
and leaving the sample uncoated, then the following applies:-
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For most non-conductors which contain no volatile components, eg water, that
would outgas in the vacuum system it is sufficient to coat the sample with a thin
layer of conducting medium such as Au, C, Au/Pd, Al etc. This layer is typically
20-30nm in thickness. There are several reasons for this coating:-

. Increased conductivity of the sample, thus minimising sample charge
up, which results in deflection of the incident beam and severe
degradation of the final image. (see Section 3.4 Specimen Charging)

. Increased mechanical stability of the sample due to increased heat
condition.

. Increase in primary and secondary electron emission.

. Decrease in beam penetration, resulting in better spatial resolution.

The two important current techniques of applying a coating are
vacuum evaporation and ion sputtering.

Gold is generally used for the following reasons:-

. High secondary emission co-efficient.

. High conduction of electrons and heat.

. Does not oxidise.

. Good granularity of evaporated or sputtered particles.

Carbon coating by evaporation is generally used if X-ray microanalysis is to be
undertaken on the sample unless, of course, the element under investigation happens
to be carbon. Aluminium could be used in this case.

More recently Pt/Pd and Aw/Pd have been used since their granularity is smaller.
Aluminium can also be used, but it has low mechanical strength and can oxidise.

Non-Conductors (Volatile)

Biological and botanical samples, by their nature, require relatively more complex
preparation procedures. The samples fall into two main categories: a) hard, b) soft.

a. Hard samples (eg bone, teeth, wood). These, if necessary, can be
washed to remove extraneous fluids such as blood and mucus, dried in air

and coated in the normal way.
b. Soft Samples

e Untreated - Soft tissue needs more specialised treatment. Most soft
tissue contains up to 90% water which must be removed without altering
the structure. If this is not done, there will be difficulty in achieving
adequate vacuum in the SEM, and complete or partial sample collapse and
distortion will occur.
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Some botanical specimens can be observed successfully for short periods
provided that thought is given to the selection of instrument parameters, eg
using a low accelerating voltage and beam current.

* Replication - Although it is usually only adequate for low magnification
work and for comparatively simple surface topography, replication has the
advantage that the sample can be totally preserved. One method of
replication uses an elastomeric material such as silicone rubber to obtain an
impression. A positive replica is then obtained from the impression by
coating it with low-viscosity polymethylmethacrylate solution, allowing
this to dry and then stripping the resultant film away. Coating and
examination follow in the usual manner.

With suitable modification, transmission electron microscope replication
techniques can be utilised.

¢ Chemical Pre-Treatment - This technique involves chemical fixation
of the material to strengthen the tissue. There is a large range of chemicals
used in this process (eg glutaraldehyde and osmium tetroxide) and there
are numerous publications discussing the benefits of each. After fixation,
it is necessary to displace the water in the sample by a solvent to aid
drying. The method must be such that the specimen suffers no physical
change. The commonest drying agent used is a series of ethanol/water
mixtures through to 100% ethanol. Having replaced the water present in
the sample there is a choice of three methods for drying:-

i) Freeze Drying
This is a complicated procedure, and may not be too successful.
The sample is quench-frozen and maintained at low temperature

(about -130°C) until the sublimation process is complete.

ii) Air Drying

It is worthwhile first transferring the specimen to a solvent of low
volatility (eg amyl acetate) as the last stage of dehydration. The
solvent is then allowed to evaporate from the sample under
carefully controlled temperature conditions. As this is a gentle
process, there is little chance of any specimen damage.

iii) Critical Point Drying

The specimen is dehydrated as previously described and the
solvent replaced with a liquified gas in small pressure vessel. The
vessel is then heated to above the critical temperature of the
selected gas. Under these conditions the liquid and vapour phases
have the sample physical properties, so that on venting, the liquid
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vapourises across cell boundaries and therefore minimum sample
distortion occurs.

The sample may however, undergo some mechanical shock during
the venting stage. The choice of gas for this process is limited by
the number of available gases which have a critical temperature
relatively close to ambient, a safe pressure level and low toxicity,
whilst at the same time being completely miscible in all
proportions with the solvent selected in the final stages of
dehydration. It is important to replace the solvent completely

with the liquified gas (usually carbon dioxide) before venting.

General Considerations

The methods described above for soft tissue preparation are mainly for
secondary electron imaging. The problems facing the biologist or botanist
who wishes to undertake X-ray microanalysis are different in that the
requirements in this case are to maintain the element(s) of interest in their
original position in the sample. There is not one major preparative
technique for biological/botanical samples. Where possible, several
combinations should be tried for a particular type of sample, giving prime
consideration to the information sought. Once a technique has been
established, instrument parameters and specimen coating methods must be
carefully considered.

Using the Digital Image Store

Noise

The image store of the Stereoscan 430 is particularly useful in situations where use
of poor signal-to-noise conditions is forced. In these circumstances, noise can be
removed from the image before photography. For example, samples that exhibit
charging often require the use of a very small probe current. Noise arises from the
electronics of the video system and gives a grainy appearance to the image. This
occurs in situations where there is little signal detected from the specimen and the
photomultiplier gain (or amplifier gain for BSD) is increased to compensate. A low
signal can be the result of a small electron emission co-efficient of the sample or of
the choice of microscope operating conditions, eg low probe current. The amount
of signal compared to the noise content is known as the signal to noise ratio.

Noise Reduction
Prior to the use of digital techniques the only way to reduce the noise in the signal

was to use a slower scan speed. This allows the beam to dwell longer on each
scanned point of the specimen so that more signal is collected. Digital methods of
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noise reduction utilise the fact that the noise is random in nature. If the signal from
a single specimen point is sampled repeatedly and the average taken, noise will be
averaged out and the signal will be reinforced.

On the Stereoscan 430 the concept of scan rate is replaced by pixel averaging. The
pixel average parameter determines the number of times each pixel is sampled with
the average making up the signal to the image store. Increasing the pixel averaging
has an effect similar to using a slower scan rate (thus the image takes longer to
acquire, but will have less noise in it). Reduce raster mode does not change the
pixel averaging, but does reduce the cycle time (the time taken to perform an image
acquisition) which makes adjusting certain parameters easier.

Additional noise reduction of two other types may be applied.
Frame Average

When frame average is selected the live signal is proportionally mixed with the
store signal so that the image reflects the average of the recent frames. The
proportion of live to stored can be adjusted with the parameter N which represents
the number of frames to be averaged. Frame average can be selected with any level
of pixel average, but is generally most useful at the faster speeds (lower pixel
average) where a larger amount of noise reduction can be obtaineed without
introducing a long cycle time.

Line Average

Selecting the line average causes each line to be scanned a number of times before
the scan moves on. The average line signal is stored and displayed.

Choice of Technique

The decision as to which noise reduction technique is to be used will depend to
some extent on the specimen being imaged. If it is sensitive or prone to charging
then frame average may well be the best option because the beam does not dwell at
one place for a long period of time. Line average is used when the result of the
noise reduction needs to be seen without waiting for the cycle to complete.
Increased pixel average is most useful when doing live photo records (where the
image goes directly to the HRRU without being processed in the image store).

On the Noise Reduction panel there are two options for freezing the store. At End
is used to freeze the store when an acquisition cycle completes, whereas Now
causes the image to freeze as soon as the button is selected.

Stereoscan 430 Operator Manual



Chapter 3 Advanced Operation 77

3.7.

371

Customising the User Interface

Careful thought and design has gone into producing a user interface which meets the
requirements of Stereoscan 400 users. However it is recognised that user
requirements are so diverse that it is impossible to provide one interface which
meets every requirement. Therefore several features are provided which allow the
user to customise the interface to meet their individual needs. The following parts
of the user interface can be customised:-

. The display look up table (LUT)

. The macros and function keys (F5 - F8)

E The status display

. The appearance and operation of the tool bar
The Display LUT Editor

The display LUT editor provides a mechanism for altering the mapping between the
grey level in the image store and the way in which the pixel is displayed on the
monitor. The LUT is really three LUTs in one, a mapping exists for each video
colour (Red, Green and Blue). If these three mappings are the same then the image
will appear as monochrome (grey) on the monitor.

There is one important rule to bear in mind when editing LUTs, which is:-
Each grey level must have one and only one LUT value.

It is however permissible for several grey levels to be mapped onto a single colour
(or shade), in fact this is one of the more useful features of the display LUT.

The LUT Editor

The display LUT editor is selected from the Edit menu. Its own menu provides
option for both grey and colour LUTSs as well as facilities for loading and saving
LUT files. Before considering the menu options in detail it is necessary to
understand the concept of a LUT, as seen by the system.

A LUT is a collection of points which are connected by arcs. The simplest LUT has
Just two points (0,0) and (255,255) connected by a straight line. Various operations
can be performed on points (they can be added, moved or deleted), other
operations are performed on arcs (actually on the two points defining a arc)
including level and threshold.

In the LUT editor, the middle and right mouse buttons have a special meaning. The
middle button is used to select the colour being adjusted (when editing a colour
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LUT). The right button is used to select between move, add and level modes, which
determine the operation on the points.

Move

When in move mode, selecting a point in a LUT allows it to be moved. A point can
be positioned anywhere on the vertical scale, but must lie between its neighbour
points along the horizontal scale. It is always the point nearest to the cursor when
the left mouse button is clicked which will move.

There is one further restriction required to ensure the LUT remains consistent, that
is the two end points of the LUT can only be moved vertically.

Add

On a click of the left mouse button a point will be added at the cursor position. The
LUT curve will be redrawn so that the point is included at its proper place. Note
that point delete mode can only be selected from the Points menu appearing in the
Grey and Colour options.

Level

In level mode, a click on an arc of the LUT will cause that arc to become horizontal.
This is accomplished without moving the end points of the arcs either side of the
selected arc, so it is sometimes necessary to introduce a new point at either end of
the selected arc. Once the arc is horizontal it can be dragged upwards or downwards
to the desired level.

A similar function exists for the vertical steps in the LUT curve, that is the
Threshold function which can be selected from the Points menu. It allows a step in
the LUT to be moved left or right.

Other Menu Features
The display of the LUT diagram can be scaled as 1 or 2 pixels per grey level in the
horizontal scale. This is done with the Scale menu option.

The Reset menu option should be used with care. It will replace the existing LUT
with the default linear grey LUT. Although Reset appears in several menus, its
operation is always identical, with one exception - when it is selected from the
Colour->Points menu, only the currently selected colour is reset. In all other cases
the entire LUT is reset to linear.

When setting up a LUT it is sometimes useful to refer to the grey level of an area of
the image, the atPoint function allows this. Selecting atPoint displays a line cursor
on the LUT profile. Then when the mouse is clicked on a point of the image, the
grey level at that point is reflected by the position of the line cursor.
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There is one further feature which is often helpful in setting up LUTs, that is the
Grey Wedge option on the Grey menu. If the store is frozen, this option can be
selected to fill the store with a grey slope image (black on the left, to white on the
right). This image clearly shows the effect of any changes to the display LUT in
either grey or colour mode.

Colour LUTs

Colour LUTSs can be set up to achieve a variety of effects. It is possible to have a
normal grey LUT, with a different colour set up for the low grey levels, to achieve a
background effect for an image. A blue/red LUT for the low and high grey levels
(described earlier in this chapter) may be useful for setting brightness levels, the
operations to set it up are described below as an example.

A high/low limit LUT:-

Select Red colour (middle mouse button)
2. Select Add Point mode (right mouse button)
3 Add a point on the red line at the lowest grey level required (using

grey wedge and atPoint if necessary)

4. Add a point at the highest grey level required
5. Repeat the above steps for green and blue
6. Select Level mode (right mouse button)
i Select blue (if not already selected)
8. Select the low arc (between 0 and the low point)
9. Move the blue level to maximum (highest point)
10. Select the high arc
i1 Move the blue level to minimum
12. Select Green
13. Select the low arc
14. Move the green level to minimum
15. Select the high arc
16. Move the green level to minimum
17. Select Red
18. Select the low arc
19. Move the red level to minimum
20. Select the high arc
2. Move the red level to maximum
22, Save the LUT as points or a LUT if required (see Saving and
Loading LUTs)
Monochrome LUTs

Monochrome LUTSs operate in two distinct ways. Points mode is similar to colour
LUTs, Formula mode is an entirely different approach. In points mode the LUT
consists of a series of points connected by straight lines, but in formula mode an
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equation is used to calculate the grey level at any given point. In this mode changes
to the LUT are made by changing the coefficients of the LUT equation. Different
equations are used for the different types of control required. The equation can be
either Brightness and Contrast or Gamma. In addition to these the whole grey
profile can be inverted with the Invert option (only available in formula mode), and
plotted on the LUT display with the Plot option.

Brightness and Contrast

When Brightness or Contrast is selected a scroll bar appears at the bottom of the
display LUT window. For brightness it controls the vertical position of the curve,
for contrast the slope of the curve is adjusted. The effect of these controls is similar
to the signal level brightness and contrast controls and can be used to adjust the
overall appearance of the image. The LUT is determined by the straight line
equation:-

y=ax+b

where a is the contrast and b the brightness. Any point which is less than zero is set
to black and any point exceeding 255 is set to white.

Gamma

The Gamma option allows the LUT to be defined as a curve. The gamma parameter
can be adjusted either way from a straight line so that the LUT can be made to
expand the low or high grey levels. This function can be used to enhance an image
where a large amount of detail is contained within a few grey levels.

Points and Steps

In addition to the formula mode monochrome LUTs, it is possible to use a
monochrome LUT in points mode (in the same way as colour LUTs). Points can be
added, moved and deleted in the same way as for colour and the level and threshold
functions are also available.

One further function is defined for monochrome LUTs, the Steps function. When
steps is selected, the LUT is turned into a monotonic series of grey level steps. The
height of each step (Amplitude), the position of the first step (Offset) and the
number of steps (Period) can all be adjusted. It is also possible to subsequently
modify the LUT using the point functions.

Saving and Loading LUTs

The are two ways of saving and loading LUT files. A LUT can be saved as a series
of values (one for each grey level), or it can be saved as a series of points. Both
types of LUT can subsequently be reloaded, but only a points file can be modified
after it has been reloaded. Points and LUT files have different default extensions,
.OLT for LUT and .DLU for points files.
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372

Monochrome LUTs defined in formula mode can only be saved as LUT files.

The Macro Editor

A macro is a sequence of instructions which can be executed by the user to achieve
a specific result. Macro execution is initiated in several ways:-

From icons

By panel buttons

By function keys

When restoring conditions

In addition it is also possible to edit, load and save macros and macro libraries. It is
also possible to record a sequence of user instructions to generate a macro.

Each macro has a name which is displayed on the right of the toolbar while the
macro is executing.

Macro execution may be terminated by pressing the Esc on the keyboard or by
clicking on the macro name in the toolbar. Execution can be suspended by use of
the keyboard Pause key. A paused Macro is indicated by the ! character before the
macro name in the toolbar. The macro may be resumed by a second selection of the
Pause key.

Instructions
The following types of instruction can be used within macros:-

Calls
A call instruction executes another installed macro. The maximum nesting level of
callsis 5.

Comments
A comment provides the user with the ability to annotate a macro and performs no

action when executed.

Commands
A command executes a specific SEM command. If the command is disabled, the

macro will not step on to the next instruction.
Set Digital State

Sets the specified digital parameter into the defined state. It will not step on to the
next instruction if the parameter is currently disabled.
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Set Analogue Value

Sets the specified analogue parameter to the defined value. If the value is outside
the parameter's allowed range, then the parameter will be set to the nearest limit. It
will not step on to the next instruction if the parameter is disabled.

Set Co-ordinate Value
This instruction performs the same action as set analogue value except that it sets
the value for a pair of parameters making up a co-ordinate pair (x and y).

Stage Goto
This instruction moves the stage to the defined X, Y and Z co-ordinates. It does not

step on to the next instruction if stage movement is currently disabled.

Wait For

The wait for instruction waits until the specified state is achieved. An optional
timeout parameter may be specified (in seconds) which limits the amount of time
the instruction will wait. If no timeout parameter is specified (not zero seconds, but
no characters) then the instruction will wait for the state indefinitely.

Delay
This instruction waits for the specified number of seconds before continuing.

Pause
The pause instruction acts in the same way as the pause key. It causes the execution

of the Macro to be suspended.

Confirm
This instruction check that the instrument configuration matches the defined

configuration. If the configuration is different, the user is given the option of
continuing the execution or aborting the macro.

Message
The defined text is displayed in a dialog box until the user clicks on the OK button.
Execution of the macro then continues.

Show/Hide Panel
The show and hide panel instructions are used to display and remove panels to and

from the screen.

Load Display LUT

The load display LUT instruction loads the display LUT from the specified .OLT
file. When this instruction is inserted into a macro, the current display LUT is used
to generate a file and the user is prompted for a filename.
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Function
Performs one of the set of specially defined actions if the appropriate licences are

installed.
Control Structures

There are two types of control structure provided:-

While
If then

While Constructs
The While construct allows a series of instructions to be repeatedly executed while

the specified condition is true.lt takes the form:-

While <condition> (alternatively While Not <condition>)

other statements
End While

While Statement

The While statement is part of the While construct. If the condition defined is true
then the next instruction in sequence is executed, otherwise execution continues
after the end While statement.

While Not Statement

The While Not statement is part of the While construct. If the condition defined is
false then the next instruction in sequence is executed, otherwise execution
continues after the end While statement.

End While Statement

The End While statement is part of the While construct. When this function is
executed it resets the statement counter to the corresponding While or While Not
statement. Each While or While Not statement must have one and only one

End While statement.

If Constructs

The If construct allows selection of the appropriate set of instructions based on a
condition. It takes the form:-

If <condition> (alternatively If Not <condition> then)
other statements

optional else

other statements for else clause

End if
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If <condition> then

The If statement is part of the if construct. If the condition is true execution
continues at the statement after the If. If the condition is false execution continues
after the Else statement if one exists, or after the End If if there is no Else clause.

If Not <condition> then

The If Not statement is part of the if construct. If the condition is false execution
continues at the statement after the If. If the condition is true execution continues
after the Else statement if one exists, or after the End If if there is no Else clause.

Else statement
The Else statement is an optional part of the if construct and is used to indicate the

start of the Else Clause.

End If statement
The End If statement is part of the if construct and identifies the end of the
conditional sequence. Each If or If Not statement must have one and only one End

If statement.
Editor Facilities

The macro editor is selected from the Tools->Macro menu option. The name of the
macro is displayed in the window caption together with the mode. The macro
instructions are displayed in the window in the sequence in which they will be
executed. The menu offers a range of options which are described below:

Reset
The reset instruction clears the macro window and name (setting the name to

ANON) and inserts a comment defining the time and date in the macro window.

New
This option performs the same action as reset, except that the user is prompted for

the name of the new macro.

Rename
Allow the user to change the name of a macro.

Insert

Initiates the dialog which adds an instruction of the specified type into the macro
after the current instruction. The type of instruction is selected from a list box, then
according to the type of instruction, the user is presented with further options to

specify the instruction.
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Edit

Some but not all instructions may be edited. Selecting edit allows the text of an
instruction to be changed. If an instruction is not editable, delete it and insert an new
one.

Delete
The delete functions deletes the currently highlighted instruction.

Load/Save

A macro may be saved in a file with a.MAC extension by the save option. The user
is able to specify the filename for the file. Any .MAC files can also be loaded into
the macro editor for further alteration or for execution with the load option.

Save as Text

This option allows a macro file to be written in text format. The default TXT
extension is used and the resulting file can be read by the notepad editor. It is not
possible to load a text macro file.

Fetch/Install/Remove
The fetch, install and remove options all relate to the subject of macro libraries
which are described below.

Execute/Stop/Continue

The Execute command causes the current macro to be executed from the beginning.
Execution can be interrupted at any point with the Stop function. It is then possible
to edit the macro before selecting Continue which will resume execution of the
macro from the currently highlighted instruction.

Record

The record option allows a sequence of user interface operations to be converted
into a macro. All operations between selecting Record and the subsequent selection
of Stop are recorded as a macro.

To reduce redundant instructions only the final value of analogue
parameters is inserted as an instruction. There is no sense of time delay in
the recorded sequence, each instruction follows directly after its
predecessor. To introduce time delays, Wait For and Delay instructions must
be inserted with the editor.

Libraries
A library is a collection of macros. The Stereoscan 430 comes with a standard

library which contains the macros required by the user interface for standard calls
from menus and panels.
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All macro libraries must contain the standard macros as a subset.

Once a macro is in a library it can be assigned to a toolbar icon (see Section 3.7.4
The Toolbar Editor) or called from one of the user defined function keys.

The assignment to function keys is made entirely by the macro name. For example,
macro F5 is assigned to function key 5, while macro Shift F6 is assigned to the
shifted function key 6.

The following operations may be performed on macro libraries:-

Install
A macro can be installed into a library, which means that it will appear in the list of

macros which can be selected. If a macro of the same name already exists in the
library, the user is asked whether the old macro should be overwritten.

Fetch
Fetching a macro from a library, loads it into the edit window where it can be

executed or edited.

Remove
Removing a macro from a library deletes that macro from the library.

Save/Load
Macro libraries may be saved as files as well as individual macro files. Libraries

have the MLF extension. Note that the standard library calls should not be altered
as this could cause unexpected side effects when loading macro libraries. The
Load->Standard option is provided to allow an easy route back to the default
macro library should it be required.

Example

This macro will enable the operator to select operating conditions suitable for
adjusting the final aperture, by selecting function key F5.

Click on words in normal type, enter text and values in bold type on the keyboard:-

Tools, Macro, Macro, New, F5, OK

Insert, Instructions, Analogue, M, Mag, OK, 2000, OK

Insert, Instructions, Command, R, Reduced, OK

Insert, Instructions, Analogue, R, Red. Raster posn X, OK, 384, OK
Insert, Instructions, Analogue, R, Red. Raster posn Y, OK, 256 OK
Insert, Instructions, Analogue, R, Red. Raster height, OK, 256, OK.
Insert, Instructions, Analogue, R, Red. Raster width, OK 256, OK
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Insert, Instructions, Command, P, Pixel average 4, OK

Insert, Instructions, Command, F, Frame average

Insert, Instructions, Digital, F, Focus wobble, OK, On, OK
Insert, Instructions, Digital, W, Wobble rate, OK, Fast, OK
Insert, Instructions, Analogue, C3W, C3 Wobble Amplitude, 50
Install, Yes

Press function key F5 to see it working.

Now to save this macro:-

Click on Macro->Save, then delete the default name and enter
WOBBLE.MAC. You can then FETCH the file from the macro library or
load it from the file and EXECUTE it if required.

Saving and Loading Conditions

A further use for macros is in saving and loading instrument conditions. The
Restore macro has already been described (Chapter 1 Getting Started Section 1.4
Common Operating Routines). It is initiated from the run up icon and restores the
previous operating conditions. Those conditions are saved when the system is
closed down by the macro generator.

The macro generator builds a macro which when executed restores the previous
condition of the instrument. It can be selected at any time from the File->Save State
menu option and can be made to generate a macro to restore any combination of the
following:-

Configuration

Setup

Gun Conditions
Application Conditions
Display LUT

The user is prompted for a LUT file name (if that option is chosen) and a name for
the macro.

The Standard option is provided to set the instrument to a default state
should the restore macro be saved as some undesirable state.

Any instrument conditions macro may be loaded directly in and executed with the
Load State option. However the Preview State option has the advantage that the
conditions can be examined before the macro is executed. The preview menu also
allows the conditions to be executed (OK), edited (Edit) or changed for another set
(Fetch).
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3.7.3.

Any macro of instrument conditions that is created by the File->Save State
menu option is saved with the file extension . APP and not .MAC so that it is
easier for the operator to separate the two types of macro.

The Status Display

The status display was introduced in Chapter 1. There is a little more to it than
meets the eye. It is of course a window for displaying instrument parameters which
can be chosen using the Select menu option. But it also provides certain control
facilities which will be described in this section. The basic operation of the display
will be covered first.

Selecting a Set of Parameters

The status display can be cleared at any time using the Reset menu option. The
Select option is used to add or remove individual items from the display. when
select is chosen, a select box will appear containing a list of all the possible system
parameters which may be displayed. Highlighting a value means that it will appear
in the display when OK is selected.

The position in the list can be controlled using the scroll bar or by typing the first
one or two letters of the required parameter in the text entry box. When all the
required parameters are selected, the OK button will cause the status display to be
reconfigured to reflect the new selections.

Some of the parameters in the display may appear greyed out which means that in
the current operating mode, that parameter cannot be altered by the user.

Saving and Loading Status Display Files

It is likely that the user will require different parameters in the status display for
different activities. To avoid the need to constantly reconfigure the display, a file
save and load facility has been provided. Selecting File->Save from the menu will
cause a dialog box to appear allowing the user to specify the filename before the file
is saved. All status display files are saved with the .SSL extension. File->Load
works in the usual way (overwriting the current status display configuration).

Adjusting Parameters from the Status Display

The way in which a parameter can be adjusted from the status display varies
according to the parameter type. Parameters may be read only, analogue, binary
digital (boolean) or multi value digital. The methods of adjusting them are
summarised below:-
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Left Middle Right Left Double
Button Button Button Click

Analogue Assign o Assign to Preset Dialog Value
Left Mouse Right Mouse Values Entry
Parameter Parameter

Binary Digital Toggle

Multi Value Select Box

| Digital

Keyboard Only Dialog Value Dialog Value Dialog
Entry Entry Value Entry

Read Only - - - -

The actions listed above are defined as follows:-

Assign to Mouse
Control of the parameter is assigned to the mouse (and navigation box if

present) for adjustment.

Dialog Value Entry
A dialog box appears which allows the new value for the parameter to be

entered.

Preset Values

A select box appears which displays all the previously defined preset
values for that parameter. A new preset value can be defined as a label for
the current parameter value, or a previously defined value can be used. The
preset values are labels which can be used to set an individual parameter to

a fixed value.

Toggle
A binary digital parameter has only two states (Off/On, Yes/No, Fast/Slow,

etc). Selecting such a parameter simply changes it to its alternative state.

Select Box
A select box appears with all the possible values for the parameter in
question. A value is selected from the list and the parameter is set to it.

Whenever a double click is performed the relevant left or middle single click
action is performed before the double click action.

3.74.  The Toolbar Editor

The final option available for modifying the user interface is the toolbar editor. It
allows the actions and appearance of the icons in the toolbar to be modified. Icons
may be added, deleted or edited using the toolbar editor which is selected from the
Toolbar option of the Edit menu. Different toolbars can be loaded and saved and a
new toolbar can be installed from the editor.
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Toolbars

A toolbar is a sequence of icons with their associated bitmaps and actions. A popup
menu controls the changes to the icons in the editor. Some operations apply to the
whole list, others apply to individual icons. The former are considered in this

section.

Reset
The reset command deletes the current icon list.

Fetch
This command loads the current toolbar into the editor, overwriting any icons in the

editor at the time.

Load/Save
A toolbar can be saved as a file (with an .ITB extension). A toolbar file can be

loaded into the editor overwriting its current contents.

Install
The install option copies the icon list from the editor into the toolbar area. The

current icon list is then lost. The current toolbar is saved when the system is
shutdown.

Should the distribution toolbar be inadvertently lost, it can be restored by
selecting Novice or Expert mode (as appropriate) from the File menu.

Icon Order

The order of the icons in the toolbar can be changed simply by dragging an icon to
another position, this will swap the icon with the one currently occupying that
position. Identical icons may appear several times in the toolbar to ensure that any

given icon is always visible.

Icons

Individual icons in the toolbar can be defined to appear and behave in certain ways.
There are two types of icons, Buttons and Toggles. A button executes an action
when it is selected, whereas a toggle changes state (for example, image inverted to
not inverted or vice versa). New icons of either type may be created and also
deleted (by selecting an icon then delete on the popup menu).

A red border is used to indicate the currently selected icon. The following
properties of the selected icon may be edited:-
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Size
There are two sizes of icon available large (64 x 64 pixels) and small (36 x 36
pixels). Selecting the smaller icons allows more icons to be displayed.

Bitmaps

The bitmap associated with any given icon may be altered using the Next and Prev
options on the popup menu. Repeated selections will cycle through the set of
installed bitmaps for that type of icon.

Actions

Each icon has an action associated with a selection with the left mouse button and
one associated with the middle or right mouse buttons. The actions can be selected
using the Edit option on the popup menu. The choices available for an icon depend
on its type, but will be from the following list:-

. Command

Executes the low level command
B Panel

Displays the panel.
. Macro

Executes the defined macro
. Mouse

Assigns the selected parameters to mouse control
. Function

Executes the high level function
. State

Toggles the state of the binary parameter

Icon Example

This example shows how to add an icon to the toolbar which will select and deselect
the lowest available magnification.

1. Select Edit->Toolbar.

3 Select right mouse button while over Toolbar editor panel (to bring
up popup menu).

Select Fetch.

Select New Toggle.

Select Next (until desired bit map is selected).

Select Edit (on popup menu).

If required, enter a Default name for the icon.

Select State (for the left button action).

Select Low Mag from the list of available parameters (or any
preferred parameter), and O.K.

10.  Select Panel (for the right button action).

A0 07l v e
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I1. Select Noise Reduction from the list of available panels (or any
preferred panel), and O.K.

12.  Select O.K. on the edit panel.

13.  Select Install, and OfT.

Selecting the new icon with the left mouse button will cause the image to be

switched between the present magnification and the lowest currently available
magnification,

3.8. Trouble-Shooting

(A) |Lack of Sharpness (C) [Poor Final Image Quality
CAUSES CAUSES
Astigmatism not correct Incorrect LEVEL & CONTRAST

settings

Misaligned final aperture Incorrect acceleration voltage
Poor focusing Incorrect probe current
Sample charge - up or vibration Inadequate specimen preparation
Magnetic fields (frame sample or
external)
Poor depth of focus

Too much noise
Specimen contaminated or of low
potential reduction

Image Noise (D) [Image Distortion
CAUSES CAUSES
Probe current too low Specimen charge-up
Sample not facing electron collector | Specimen magnetism
Faulty scintillator and/or Specimen vibration
photomultiplier
Too much CONTRAST, incorrect Specimen damage
LEVEL
Dark regions of sample being External magnetic fields
observed

External vibration

Table "Summary of Image Defects”

Stereoscan 430 Operator Manual



Chapter 3 Advanced Operation

93

(A) |Operator Error
DEFECT CAUSE
(1) |Low contrast, lack of video signal |Incorrect probe current
(if probe current too low), possible
specimen damage (if too high)
(2) |Lack of image sharpness, image Incorrect final aperture alignment
shift when focusing
(3) |Less image sharpness in one Insufficient astigmatism correction
direction, poor resolution
(4) |MNoisy image, beam deflection on | Wrong scanning period
charging sample, specimen damage
(5) |Poor image quality Wrong brightness level selected
(6) |Poor image quality Wrong contrast level selected
(7) |Influence on penetration and Wrong accelerating voltage
charging
(B) |External Influence
(DEFECT) (CAUSE)
(1) |Image distortion, jagged edges in  [Magnetic fields
image
(2) |Jagged edge inimage Vibration
(C) |Sample Type and Penetration
DEFECT CAUSE
(1) |Reflected and secondary electron | Atomic number effect
images brighten with increasing
atomic number
(2) |Image shift and distortion, Charge-up
abnormal contrast and unstable
image
(3) |Deformation and cracking of Overheating (kV or probe current too
specimen, coating peeling high)
(4) |Charge-up or sample damage Incorrect or inadequate sample coating
(5) |Surface coating leading to poor Contamination
image quality

(6)

Sample deformation, damage and

charge-up

Incorrect sample preparation (especially
soft tissues elc)

Table "Image Defect Causes”
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PARAMETER |EFFECT OPTIMUM COMMENTS
CONDITIONS
Mounting on to  |Charging, Vibration |Securely attached | Use quick - drying adhesive
specimen stub (preferably conducting)
Conductivity and |Charging Good conduction to |Use conducting paint (Dag)
grounding earth
Sensitivity [0 Specimen distortion |Use:- Low beam Optimum conditions may result
beam damage current and/or low  |in poor SNR
kV, short frame
period. Focus away
from area of interest
Coating Conductivity No charging Charging seen as: local intensity
changes; astigmatism; image
distortion; dark micrographs
Coating S.E. Signal 20nm metal coating |If too thick can mask detail
Coating B.S.E. Signal Carbon coating If too thick will absorb signal
Coating C.L. Signal Carbon, aluminium |If too thick will absorb signal
coating
Coating X-Ray Signal Carbon, aluminium |Avoid interference with
coating element(s) of interest
Coating Specimen Current  |C - Material contrast | Use inverted S.C. image for best
Au - Topography _ |topography
Coating Resolution Gold/Palladium Grain size of coating may be
resolution limit
Mechanical Resolution: Cracks | Vibration amplitude |Reduce kV, and beam current
Stability in coating less than require
resolution
Eucentric Specimen tilting, No translation Use Eucentric goniometer stage
Position Stereo pairs motion during tilting | for best results
Specimen Tilting | Topography, signal | About 45° for SE1  [Found by expt.
10 noise ratio detector. Depends on sample
Zero for BSD

Specimen Tilting

Stereo Viewing

Filt difference 5-10°

Use low diff for large height
differences

Working Resolution Short Beware of final lens damage
Distance
Working Depth of focus Long Limit = Loss of resolution
Distance
Working Sample - BSD Long - Best for
Distance Distance Topog and Crystal

Orientation

Short - Best for Z-
Contrast
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